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Goal Setting 
 

Here are the challenges I’m having that motivated me to attend this course: 

 
 
 
 

 
Possible Challenges (circle those that apply to you): 

 
1. Too many inputs and to-do lists 
2. Hundreds or thousands of emails in the inbox 
3. Putting things to do on the calendar 
4. Using the inbox like a quasi-to-do list 
5. Native phone apps don’t add emails directly to the task list 
6. Requests you make of others are falling through the cracks 
7. You forget to do things you promised 
8. You “flag” items for follow-up and become blind to them 
9. Marking items as Unread creates inefficiency 
10. Filing in email folders causes space and access issues 
11. Hours spent every day processing, organizing, reading, and sorting emails 
12. Constantly “cleaning up” your email 
13. Your organizing method includes dragging emails around to different folders 
14. You feel like categorizing everything is a waste of time 
  

AH-HA! 
 
 “What has changed for me since attending this session today?” (AWARENESS) 

 
 
 
 

 

Homework 
 

 “Here are the specific things I will complete before the session next week.” (ACTION) 
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Clear Your Brain! 
 
Write down as many things as you can think of that you need to do! 
 

PERSONAL WORK 
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  

 
Think about: 
 Calls you need to 

make 
 Letters that need to 

be sent 
 Errands you need 

to run 
 Furniture to be 

bought or cleaned 
 Purchases 
 Vacations or travel 
 

 New projects you 
want to start 

 Files and records 
 Equipment to be 

bought or repaired 
 Financial matters 
 Feedback to give or 

get 
 Items borrowed - to 

return or get back 
 

 Meetings to 
schedule or attend 

 Waiting for work 
from others 

 Think about your 
desk organization 

 Closet 
 Chores or living 

space 
 

 Appliances 
 Yard 

work/outdoors 
 Health/doctor 
 Exercise 
 Books to read 
 Pets 
 Car 
 Birthdays 
 Supplies 
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One Task List with Three Views 
 
 MEMORY LIST: Holds good ideas and “someday” projects you’re not 

yet ready to work on (undated). 
 
 MASTER LIST: Contains all future projects and tasks (dated); rolls up 

from “later” to “next month” to “next week” to “tomorrow.” 
 
 HIT LIST: A limited daily to-do list, with all the High Impact Tasks 

(HITs) that keep your workflow humming along. 
 

The Basic Flow from Memory to Master to HIT 
 

Microsoft Outlook tip: Every time you think of something you need to do, 
ask yourself, “Is this something I need to do on a certain day?” If yes, 
create a new Task and fill in the Start and Due Dates. If no, leave the Start 
and Due Dates blank. Arrange the To-Do Bar by Start Date (not Due Date). 
The Today flag is your HIT list, and the No Date flag is your Memory list. 
You’ll review your Master list weekly, to see if these tasks are ready to be 
activated by adding Start and Due dates. 
 
To Set up Outlook: 
 
1. Change the Arrange By: field in your To-Do Bar to Start Date (not the 

default Due Date). 
 
2. When you think of something to do, create a new Task and fill in the 

Start Date on the day you need to begin that activity or want to think 
about it again. Enter the Due Date for the day it’s due. 

 
3. The “Today” flag in the To-Do bar now becomes your HIT list, since 

Tasks move forward automatically. 
 
4. Leave the Start and Due Dates blank for “someday” items, so they 

appear under the “No Date” flag and can be reviewed monthly. 
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Control Your Work-in-Progress with Interim Reviews 
 
Create a recurring task for each of the following: 
 

 

1. Conduct Monthly Forward Thinking

•Click the "No Date" flag in your Task List and assign Start Dates for those 
"someday" items ready to move into your workflow. Review your calendar 
and project plans to determine what you need to complete by the end of 
the month. What deadlines are approaching, what project steps should be 
started, what meetings do you need to prepare for, what travel 
arrangements do you need to make, etc. Delete out‐of‐date items or those 
that will never happen.

2. Prepare for Next Week

•Review the past week for overdue (red), incomplete, and missed tasks. 
Where did you leave a message and didn’t get a return call? Where did 
someone cancel an appointment that you need to reschedule? What didn’t 
get done that needs to? Make sure you moved any follow‐up to the 
appropriate day for action. The most successful performers are not only 
self‐starters; they are self‐finishers as well. Click the "Next week" flag as 
well and review, changing any Start Dates as applicable.

3. Plan for Tomorrow

•Before you leave work each day, analyze the Tasks you didn't complete 
under the Today flag and change the Start Date as necessary. Open the 
Tomorrow flag and change the Start Date if you know you won't get to it. 
Prioritize your list as you know it now. When new tasks pop up during the 
day, add them to your to‐do list and re‐prioritize. When you have a block of 
discretionary time, do the first item on your list. 
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1. Layout: Six Areas on the Main Screen 
 

A. Quick Access Toolbar.  
 
B. Ribbon. Uses tabs instead of menus to switch between functions: 
 

 
 
C. Folder Pane. This is the left column on the screen. This is like the 

channel selector of your television—you click where you want to go. 
It is actually made of three parts: 

 
1. Folder list shows information in a list view. You simply click 

where you want to go. 
2. Buttons show various views for that module and any links. 

(HINT: You can grab the dotted border separating the folder list 
from the buttons and pull it down. This turns the buttons into 
icons and gives you more space for your folders.)  

 
 
 
 
 
 
 
D. Information Viewer. This shows or lists the contents of the selected folder. This 

is like the actual television screen. 
 
E. Reading Pane. Detail or text of messages (like reading subtitles).  
 
F. To-Do Bar/Pane. Displays items from other folders as you select (Calendar, 

People, Tasks) 
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2. Customizing the Layout 
 
Click the View tab. Go to the Layout group and change settings on these 
three options: 
 
A. Click the Folder Pane options.  

1. Select Normal. 
2. Select Options.  

 Check Compact Navigation. 
 Move the Folders up and down so FOLDERS is first and the rest appear in 

this order: 
 Click OK (you can also get to here by clicking the three dots at the bottom) 

 

 
 
B. Click the Reading Pane options and set as follows: 
 

 
 
C. Click the To-Do Bar options (do this from every folder 

including Calendar and Tasks): 
1. Check Tasks. 
2. Uncheck Calendar and People. 
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3. Working with Tasks 
 
What is a Task? Something You Need “To Do” that Does NOT Need to be 
Completed at a Specific Time  

 
A. Clear Your Flags. Flagging an email creates a Reminder or “To Do,” but 

it doesn’t create a Task. The email stays in the Inbox, and you can’t 
manage your actions from a massive list of information (with new items 
pouring in on top of it).  

 
1. Go to your Search Folders. 
2. Click “For Follow Up” folder. 
3. Select All the items (Control-A). 
4. Right-click in the Flag column. 
5. Select Clear Flag. Ahhh now doesn’t that feel 

better? 
 
B. Create a New Task with Minimal Information. This method doesn’t 

provide a lot of data about your task but gets it in the system quickly. 
 

1. Click on Tasks in the Navigation Pane 
2. Under the Current View group, select Simple List. 
3. A little box at the top of the Task list says, “Click here to add a new Task”: 

 

 
 

4. After you click, those words disappear and your cursor starts blinking. Type the 
information in the list (by default only Subject and Due Date) by tabbing over. 

 

 

 



 

  Email Cracker-Jack Session 1 

  with Laura Stack, MBA, CSP, CPAE 

 
P a g e  | 10 

© 2016 Laura Stack. All rights reserved. Do not photocopy without permission. 
The Productivity Pro, Inc. 9948 Cottoncreek Drive, Highlands Ranch, CO 80130 
303-471-7401  Laura@TheProductivityPro.com  www.TheProductivityPro.com   

 
5. Hit the Enter key, and the task will automatically get added to the list below. 

 
C. Create a New Task with Complete Information.  
 

1. Click on Tasks in the Navigation Pane 
2. In the New group, click the New Task button. 

 

 
 
Fill in as much or as little as you wish; we’ll cover the fields in this top section first. Use 
the tab key to move through the fields: 

 
 

1. In the Subject box, type the name of the task. This is actually the only field you 
have to enter to create a task. 

 
2. The Start Date is when you want to begin working on it (the day you want it to 

appear on your daily to-do list). If you only fill in the Due Date, the Start Date is 
left at “None,” which is read as if you are starting the task today. You can enter a 
specific date, or you can type in a text string, and Outlook will figure out what 
date corresponds with it: “The first Friday of July,” or “three weeks from 
Thursday,” and it will autofill the correct date. (If you leave the Start Date and Due 
Date blank, it will still be in your Task list as a memory list item under the “No Date” 
flag.) 
 

3. The Due Date is when the task must be finished.  
 

4. Status (optional) is where you are on the Task. If 
you haven’t started, leave it on Not Started. 
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5. Priority (optional) by default is normal, but you can choose high or low. No real 
functionality here. 

 
6. % Complete (optional): as applicable 

 
7. Reminder (if you want the reminder pop-up box to come up before it’s due). 

We’ll soon see that this is rarely necessary, because you’ll use the built-in list. 
 

8. Text box: enter notes and instructions about the task and any other information 
you’ll need to complete it (hyperlinks, etc.). 
 

9. There are many other options under the Insert, Format Text, and Review tabs.  
 
D. Schedule a Recurring Task. These are great for quarterly tax payments, 

monthly newsletters, weekly plant watering, etc. You enter the task once, and 
Outlook will automatically create the next task for you. 
 
1. In the Recurrence group, click the Recurrence button. 
2. Select the frequency in the left column (Daily, Weekly, Monthly, Yearly). Each 

choice changes the exact choices available for when the task recurs. 
3. Click OK.  

 
4. Change the Start Date to match the Due Date. 
5. Click Save and Close. 

 
E. Create a Regenerating Task. This is different than a recurring task in the sense 

that the next one is only scheduled a certain time period after you mark the last one 
complete. So let’s say you generally like to post a blog entry every Friday, but you 
missed last Friday and didn’t get to it on Tuesday. A regenerating weekly task 
would now schedule the next posting for the following Tuesday. 

 
1. In the Recurrence group, click the Recurrence button. 
2. After selecting the Recurrence button, select the “Regenerate new task…”  
 



 

  Email Cracker-Jack Session 1 

  with Laura Stack, MBA, CSP, CPAE 

 
P a g e  | 12 

© 2016 Laura Stack. All rights reserved. Do not photocopy without permission. 
The Productivity Pro, Inc. 9948 Cottoncreek Drive, Highlands Ranch, CO 80130 
303-471-7401  Laura@TheProductivityPro.com  www.TheProductivityPro.com   

F. Remove Completed Tasks from Your View Rather than Crossing Out. 
You’ll need to repeat this procedure for any views that have strike-outs. 

 
1. Click on Tasks. 
2. Click on the View tab. 
3. From the Current View group, Change View to Simple List. 
4. From the Current View group, click View Settings. 

 

 
 

5. In the Advance View Settings dialog box above, click on the Filter button. 
6. Click the Advanced tab. 

 

 
7. Click on the Field button on the left side in the middle of the box. 
8. Click Frequently-used fields. 
9. Click Complete.  
10. The default Condition and Value will automatically be filled in with Complete, 

Equals, and No, which you want to keep. 
11. Click the Add to List button. 
12. Click OK to return to the View Summary Box. 
13. Click OK again. 
14. When you check the Complete box, it will now be removed from the Simple list. 

(It’s not deleted—when you click the Completed Tasks view, all your tasks are 
there.) 
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G. Change the View in Your To-Do Bar. 
 

1. At the top of your to-do bar, click the heading called 
“Arranged by.” In the drop-down, select Start Date 
(instead of Due Date) and also Show in Groups. This will 
make sure you see the task on the day you need to begin 
working on it, not the day it’s due. 

2. Click View Settings… 
3. In the Advanced View Settings: To-Do List dialog box, 

click on the Filter button. 
4. Click the Advanced tab. 
5. Click on the Field button. 
6. Click Frequently-used fields. 
7. Click Owner.  
8. The default Condition and Value will automatically be filled in with Owner, 

contains, which you want to keep. 
9. In the Value field, type your first name. 
10. Click the Add to List button. 
11. Click OK to return to the View Summary 

Box. 
12. Click OK again. Now only YOUR tasks (not those you’ve assigned) will show in 

the To-Do bar. 
 
H. Changing the Start Date. You can either open a task and change the start date 

to move it down the list, or simply drag it down the master list. 
  
I. Modify Your Master Categories List. 

 
1. Click on Tasks. In the Tags group, click Categorize. 
2. Select All Categories (at the bottom): 
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3. In the Color Categories dialog box, rename the categories to reflect your projects, 
responsiblities, committees, people, geographical areas, etc., that describe the 
categories of tasks you work.  

4. Delete any that aren’t in use to make your list smaller (you can always add them 
back in later). 

5. If you like a particular color that isn’t in use, select New… and pick the color 
from the list.  

6. Hint: if you put a period in front of the category name, it goes to the top of the 
list. Here are some categories you could use: 

 .Projects: Business 
 .Projects: Personal 
 .Ideas 
 .Objectives 

 
J. Tag a Task with a Category.  
 

1. Create a New Task (for each step of the project). 
2. In the Tags group, click the Categorize button. 
3. Select the appropriate Category name or names 

(you can tag a task with multiple categories). 
4. Save and Close.  
 
Hint: create an overall project plan in one task, tagged with the .Projects: Business 
category, and then copy/paste each individual step of the project into its own Task, 
Categorized by the project name itself. 
 

K. Group Tasks by Category. This shows your data in groups you can open and 
close. 

 
1. Select Tasks in the Navigation Pane. 
2. Click the View tab. 
3. In the Arrangement group, click Categories (or any other desired view). 

 

 
 

4. Open and close the Categories by clicking the arrow next to each category to see 
all open tasks for that category/project.  
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5. If desired, expand the menu with the arrow in the lower right hand corner, and 
check or uncheck “Show in Groups.” I prefer to turn the groups off for a simple 
interface. 

 
L. Create Task Folders. You can organize your Tasks into Folders, just like you do 

with email, for different areas of your life (volunteer work, kids, personal, etc.). 
 

1. Right-click on Tasks. 
2. Choose New Folder. 
3. Type the name of the folder. 
4. Under Folder contains: make sure Task Items is selected 

 

 
 

5. Click OK. You now have a blank to-do list for that area of your life. 
 

M. Sort Your Tasks. The Current View filter shows you a subset of your tasks. Then 
you can click the View tab to arrange them in a particular order. 

 
1. Select Tasks from the Navigation Pane. 
2. From the Home tab, under the Current View group, select Simple List. 

 

 
 

3. Click the Subject column. (For tasks related to the same project, if you always 
start the Subject with the same project name, code, or numbered list, all your 
tasks can now sort in alphabetical order and stay together.) 
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4. Or select Completed Tasks and then click the Date Completed column to see the 
most recent you completed. 

 
N. Change the Task Options. 
 

1. Click the File tab and select Options. 
2. Select Tasks. Next to the Task Options 

button, set the default reminder box time (I 
use 9:00). 

3. Select Task Options. 
4. Choose colors and check boxes. 
 

 
 

O. Find a Task. In the upper right corner of any view (Simple list, Completed, 
Assigned, etc.), type the term you’re looking for in the Search box. Hint: you can also 
click “All Outlook Items” in the Scope group to expand your search to every folder.  
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4. Columns 
 
Often there are too many fields in a view than can be displayed, or you don’t need to 
see all the data that is showing. The fewer fields in the view, the more fully you can 
read the information. Sometimes it helps to add, remove, move, or reformat columns. 
 
A. Add a column. 

1. Right-click on any column heading. A drop-down menu will appear. 
2. Select Field Chooser. 
3. Click and hold on the field. 
4. Drag the field into the table where you want it. 
5. Two red arrows will appear. 
6. Drop the field to add it. 

 
B. Remove a column. 

1. Right-click on the column heading you’d like to remove. A drop-down menu 
will appear. 

2. Select Remove This Column. 
3. Alternatively, you can click the column heading and drag it out of the view. 

 
C. Move a column. 

1. Click and hold the column heading you’d like to move. 
2. Drag the field to the location of the table where you want it. 
3. Two red arrows will appear. 
4. Let go of your cursor to finish moving it. 
 

D. Widen/shrink a column. To see more data in the table/list view: 
1. Place your cursor on the line between two column headings. 
2. The cursor will turn into a crosshair. 
3. Move the line to the left or the right to change the width of the desired column. 

 
E. Format a column. 

1. Right-click in the column heading area. A drop-down menu will appear. 
2. Select Format Columns. 
3. Select the field you want to change. 
4. Select the desired formatting options for that column. 

 
F. Put the following columns in your Tasks Views: 
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Educational Resources by Laura Stack 
 

Screenshots of Microsoft Outlook Tips and Tricks: www.TheProductivityPro.com/Laura  
 
200+ Microsoft Outlook online training videos: www.TheProductivityPro.com/Outlook. Use coupon 
“Outlook20” for an additional $20 off! 
 
What to Do When There’s Too Much to Do book site: www.TheProductivityPro.com/whattodo  
 
Execution IS the Strategy book site: www.ExecutionIsTheStrategy.com  
 
SuperCompetent book site: www.SuperCompetentBook.com  
 
Doing the Right Things Right book site: www.3TLeadership.com  
  
Laura’s YouTube channel: www.youtube.com/theproductivitypro  
 
Subscribe to our weekly one-minute personal productivity video training series “The Productivity 
Minute”: www.theproductivityminute.com/   
 
Link with me! www.linkedin.com/in/laurastack 
 
Follow me on Twitter: www.twitter.com/laurastack  
 
Become a Fan of The Productivity Pro®: www.facebook.com/productivitypro  
 
Sign up for my free monthly newsletter, The Productivity Pro®: 
www.theproductivitypro.com/subscribe/  
 
Subscribe to my blog: www.theproductivitypro.com/blog/ 
 
Laura’s website has over 150 free articles for download: www.TheProductivityPro.com/articles  
 
FREE downloadable worksheets, checklists, and resources: www.theproductivitypro.com/free/  
 
Take the quizzes FREE from Laura’s books: www.theproductivitypro.com/quizzes/  
 
Get a FREE tip of the day via email: www.theproductivitypro.com/tip-of-the-day/  
 
Resources for purchase (books, CDs, DVDs, self-study audio, video training, MP3s etc.): 
www.theproductivitypro.com/products-page/  
 
Laura Stack keynotes: www.TheProductivityPro.com/keynotes  
 
Laura Stack training: www.TheProductivityPro.com/training  
 

 
I would welcome the opportunity to come to your organization to give a seminar or speak at an 

upcoming meeting! Please reach out to me anytime at Laura@TheProductivityPro.com. 
 


